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Introduction 

Welcome to Unit Standard 102 v6 Consolidate keyboarding skills and produce accurate text 
based documents with Microsoft Word 2013. 
 
This book has been written using Microsoft Word 2013 with Windows 8. (The Windows 7 
operating system can be used. However screen shots will differ slightly from those shown in 
this book.) 
 

Default Settings 

Before commencing this course you will need to check (and amend if necessary) the default 
settings for Word 2013 as described on pages ix to xi.  This will ensure that all exercises and 
instructions in this book will work exactly as they should.   
 

What you will learn 

In this course you will learn how to - 

 use keyboarding skills, including shortcut keys to produce text 

 consolidate keyboarding skills to produce text with accuracy 
 

How you will learn 

This book is divided into sections.  Each section page lists the learning outcomes for that 
section.  You will work through each section and do all exercises (or those instructed by your 
tutor).   

A Practice Assessment is included at the end of the section.  Our books include accumulation 
and consolidation of learning which carries across each section.   
 
After you have completed the book your tutor will give you the actual Unit Standard 
Assessment.   
 

Word meaning boxes 

Sometimes you will see a box at the left side of the page of a line that has dotted underlining. 
This box will contain information to help you understand the meaning of the underlined word 
(or how that word is formed).  An example is shown below. 
 
Data can therefore be altered to re-calculate budgets and to forecast results using different 
sales figures.  Worksheets can be saved, opened and printed as required. 

 

  

forecast  
=  to 
calculate a 
future 
result  
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Different Word buttons 
Depending on the size of your Word screen buttons on the ribbon may vary to those shown in 
this book.  The icon with the word of that feature may show, or the icon only. 
 

For example, the Copy button in the Clipboard group on the Home tab may be displayed in 
either of the following ways. 

  OR   

The Symbol button can show as either - 

 OR  
 

Shortcut keys 
Shortcut keys are indicated in the left margin, usually the first time they are used.  An example 
follows. 

1 Click on the Save button  on the Quick Access Toolbar  . 

2 Type a file name for your document then click on Save.  
 

Glossary 
Generally when a word(s) is first used that is a technical term or a word that you may not know 
that relates to an exercise, or a particular Word 2013 feature, a description is given.  You will 
also see that such words are in bold.   

These terms are listed on each section page, an example is shown below.  Explanations are also 
included in the Glossary at the end of the book. 
 

 

 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

AutoCorrect Format Replace 
Clipboard Microsoft Office Help Selecting Text 
Correction Signs Move Text Synonyms and Thesaurus 
Cut Navigation Pane Typing Replaces Selection 
Drag and Drop Proof-reading Undo 
Find Redo  

 

  

Ctrl S 
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Icons used in this book 

This book contains icons to help guide you in your learning.   

The following list shows the icon and its meaning. 

 

 Learning Outcomes 
Learning Outcomes are displayed on the section page and describe what you will learn in that 
section. 

 
 

 EXERCISE 1 
These are the exercises that you are required to do.  Often there will be an introduction 
sentence to tell you what you will be doing in that exercise.   
 
 

These are notes for your information. 

 
 

 Practice Assessment 

Each practice assessment covers consolidation of topics learnt in that section and provides 
practice for students prior to sitting the actual Unit Standard Assessment. 
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Changing Defaults 

Default settings may have already been changed in your Word 2013 program.  If not, you can 
use the following instructions to change these. 

Font and Font Size 
You can check if the font and font size have been changed by looking at the Font box on the 

 tab.  If it shows  then it has not been altered.  Change the default 
font to Arial 11 pt as follows: 

1 Click on the Font Dialog Box Launcher  which will display the 
Font dialog box. 

2 Change the Font: to Arial and the Size: to 11 pt. 

3 Click on . 

4 Ensure the following option is selected for the font to be applied to All documents based 
on the Normal template.  

 

5 Click on OK. 
 

Spacing 

 Click on the  tab and if 10 pt Spacing After is displayed as shown below then 
this has not been altered.  (Use the instructions below also if 8 pt After is displayed.) 

 

Remove 10 pt spacing as follows. 

1 Click on the Paragraph Dialog Box Launcher  which will 
display the Paragraph dialog box.   

2 Change the Spacing After: to 0 pt as shown below.  

 

3 Click on .   

4 Ensure All documents based on the Normal template is selected then click on OK.   
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Margins 

 On the  tab click on the Page Setup Dialog Box Launcher 
 which will display the Page Setup dialog box.   

If margins are displayed as 3.17 cm change them as follows.  (If they have been changed to 
those shown below click on Cancel.) 

1 The Top: margin will be selected, ie .  Type:  2.54 then press the Tab 
key.  Repeat this until the margins are displayed as shown below. 

. 

2 Click on .   

 

3 Click on Yes.   

 

 

Bullets and Numbering 
When bullets and/or numbering are inserted in Word 2013 a style is applied to these features.  
This can prevent spacing before and after, or spacing options to be used with the Line and 
Paragraph Spacing button.   

You will therefore change bullets and numbering to be applied using the Normal style as 
follows: 

1 Click on the  tab and select . 

2 Click on  at the left. 

3 Ensure a tick is displayed in the following . 

4 Click on OK. 
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Dictionary 
Microsoft Office 2013 does not have an inbuilt dictionary.  We recommend that you download 
the Bing Dictionary as instructed below.  

(If another dictionary has already been added captures in our Word 2013 books will be very 
similar but may not be exactly the same.) 

You will need to be connected to the Internet to be able to download the dictionary and to use 
it. 
 

1 Click on the  tab then click on . 

2 In the Apps for Office dialog box click on which will take you to the 
Microsoft Apps Store.   

(If other apps have been installed you need to click on . 

3 In the Search box at the top of the window type dictionary as shown below. 

 

4 Click on the Search button . 

5 Click on the following dictionary which we have selected because it is FREE and has the 
highest star rating.  It can also be used in Excel 2013. 

 

6 Click on  then on  

The Bing Dictionary will now show on the  button and will be used for spelling and 
grammar checking, synonyms and thesaurus. 
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Save Options 

When a document is saved you will be requested to select the location, ie Computer then click 
on the Browse button and select the folder required.  You can eliminate this procedure by 
selecting the location and saving directly to the Save dialog box and therefore bypass Backstage 
view.   

For the purposes of this book we have used My Documents folder as the default folder.  This 
means that files you open and save will be on your hard drive. 

 

If you wish to open and save files to SkyDrive (ie the cloud) use instructions on the next page. 

 
Use the following instructions to specify My Documents as the default file location: 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the Documents folder is displayed as the Default local file location as shown 
below.   

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 

5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

 

6 Click on OK. 
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SkyDrive 
SkyDrive is a cloud storage application from Microsoft.  It is one of the major online file storage 
options competing with Dropbox and Google Drive. 

Because files are stored “in the cloud” it means that you can access those files from anywhere 
in the world because you will always have access to the SkyDrive application and your files.  You 
do however need an Internet connection to be able to update those files. 

 

 
Saving to SkyDrive 

SkyDrive is automatically set up when Microsoft Office 2013 (ie Office 365)  
is installed on your computer.  A SkyDrive folder will be displayed on the 
Navigation Pane in Windows Explorer as shown at the right.   

Files can be saved manually by clicking on the Save button  on the Quick 

Addess Toolbar, specifying a name for your file then clicking on the  icon (you may 
wish to double click on Documents and save to that folder). 
 

SkyDrive as the Default File Location 

Use the following instructions if you wish to specify SkyDrive as your default file location. 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the Documents folder is displayed as the Default local file location as shown 
below.   

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 

5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

6 Click on  at the right of Default local file location: and select . 

 

7 Click on OK. 
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SkyDrive Website 

You can log in to the SkyDrive website using your web browser with your login name and 
password. 

The website is www.skydrive.live.com. 

 

You can upload photos and use files and share files. 

New files can be created through SkyDrive by clicking on  and selecting the 
program you wish to use, eg Word (web applications in SkyDrive are slightly cut-down 
versions of Office 2013 programs). 

 

 
Sharing Files 

From within Word 2013 you can save files to SkyDrive (usually to the Documents folder).  You 

can then click on the  tab, on  and invite people to share files in SkyDrive.  (For 

further information click on the Help button  in the Share screen.) 

Alternatively, you can right click on a file in the SkyDrive website (see above) and select Sharing. 

Use Google in your web browser to search for additional information on SkyDrive.  
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NZQA Outcomes and Evidence Requirements 

Unit Standard 102 Version 6 
 

Title Consolidate keyboarding skills and produce accurate text based 
documents 

Level 1 Credits 3 

 

Purpose This unit standard is for people who wish to build on existing basic 
keyboarding skills for employment or education. 
 

People credited with this unit standard are able to use keyboarding 
skills, including shortcut keys, to produce text, and consolidate 
keyboarding skills to produce text with accuracy. 

 

Classification Business Administration > Business Information Processing 

 

Available grade Achieved 

 

Entry information 

Recommended skills and 
knowledge 

Unit 101, Develop and use keyboarding skills to enter text. 

 

Explanatory notes 
 

1 All activities associated with this unit standard must comply with occupational health and 
safety guidelines and recommendations in relation to working environment and work 
practices.  Reference for this unit standard includes OSH 3211 AFC: 1996 Approved Code of 
Practice for the use of Visual Display Units in the Place Of Work.  Occupational Safety and 
Health Service: Department of Labour, available at 
http://www.osh.govt.nz/order/catalogue/pdf/vdu-ac.pdf. 

 

2 Accuracy calculation – five keystrokes represents an average word.  Keystrokes include 
punctuation and spacing.  One error only is counted in each word.  A 98% accuracy level allows 
two errors per 100 words. 

 

3 For assessment, candidates must demonstrate the ability to use shortcut keys to layout the 
documents and format text. The use of a minimum of three shortcut keys must be 
demonstrated.  

 

4 Spelling, grammar, vocabulary, and punctuation in the documents must be consistent with the 
nature and purpose of the business or organisational information required.  Candidates must 
be given the opportunity to proofread their work prior to submission. 

 

5 The following legislation and subsequent amendments provide reference, where needed, 
for this unit standard: 
Health and Safety in Employment Act 1992. 
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Outcomes and evidence requirements 
 

Outcome 1 
 

Use keyboarding skills, including shortcut keys, to produce text. 
 
Evidence requirements 
 

1.1 Layout principles are used to produce sentences, paragraphs, and page layouts as 
required. 
Range page margins, line spacing, alignment. 

 
1.2 Paragraphs produced are consistent with the format of text output required. 

Range may include but is not limited to – justified (blocked), first line indent. 
 
1.3 Formatting techniques applied to enhance text are consistent with the format of text 

required. 
Range bold, italics, capitals. 

 
Outcome 2 
 

Consolidate keyboarding skills, including shortcut keys, to produce text with accuracy. 
 
Range text output is a minimum of three documents of three paragraphs each. 
 
Evidence requirements 
 

2.1 Short paragraphs of alphanumeric text containing 50-100 words are keyed in 
accurately from prepared copy. 

 
2.2 Text production includes the use of figures and words in relation to the style required. 

Range may include but is not limited to – words or figures to represent 
numbers, dates, fractions, currency symbols, time, measurements; 
evidence of four examples is required. 

 

Planned review date 31 December 2015 
 

Status information and last date for assessment for superseded versions 

Process Version Date Last Date for Assessment 

Registration 1 28 February 1993 December 2011 

Review 2 27 June 1996 December 2011 

Review 3 28 April 1997 December 2011 

Review 4 28 June 1999 December 2011 

Review 5 26 September 2005 December 2012 

Review 6 17 December 2010 N/A 

 

Accreditation and Moderation Action Plan (AMAP) reference 0113 
 

This AMAP can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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Correction of Errors 
Paragraphs 
Bold, Underline, Italics 
Line Spacing, Centring 

 
 

 

 Learning Outcomes 
 

At the end of this section you should be able to -  

 Understand text processing 

 Apply ergonomics 

 Start your system, understand the screen and defaults 

 Sit correctly at your workstation and use correct fingering 

 Correct errors 

 Use block, first line indent and hanging paragraphs 

 Change line spacing 

 Use bold, underline and italics 

 Change alignment of text 

 Horizontally and vertically center text 

 Indent paragraphs and insert bullets and numbering 
 
 
 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

Block Style 
Change Case 
Defaults 
Ergonomics 
First Line Indent 
Font 
Hanging Indent 

Hard copy 
Justified Vertical Alignment 
Kerning 
Line Spacing 
Micropause 
Point Size 
Sans Serif Font 

Serif Font 
Soft Copy 
Vertical Alignment 
Vertically Centred 
Word Count 

 

Section 

1 
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Introduction 

Unit 102 consolidates keyboard learning and accuracy.   

Instructions in this manual will cover Microsoft Word 2013. 

 Any illustrations from the Word program will be in Microsoft Word 2013. 

 Instructions will be displayed as shown below. 
 

To change left and right margins - 

1 Click on the  tab at the top of the screen. 

2 Click on the Page Setup Dialog Box Launcher as shown below, to display the Page Setup 
dialog box. 

 

3 In the Margins section, type in measurements in the Left: and Right: boxes. 

4 Click on OK. 
 
 
 
  

Page Setup Dialog 
Box Launcher 

 

Mouse 

 Printer 
System Unit   

Keyboard  

Monitor  
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Ergonomics 

Ergonomics is the study of the efficiency, comfort and safety of people in their working 
environment.  In the office/computing sector, the field of ergonomics plays an important role 
in the production of monitors, keyboards and furniture, specifically in ensuring good design 
techniques that avoid the cause of backaches and muscle cramps.   

Learning how to sit at a desk and use your computer in an ergonomically sound manner will 
reduce the risk of health problems and ensure that you are comfortable in your working 
environment. 

 

The New Zealand Department of Labour has published an approved Code of Practice for the 
use of Visual Display Units covering all of the ergonomic factors that should be considered in a 
workplace.  This is available on our web site (Resources tab, Free Resources) at 
www.cherylprice.co.nz. 

The monitor should be positioned so that it is straight in front of the operator, an arm’s length 
(40cm - 90cm) away from the eyes.  The top of the viewing area of the screen should be just 
below eye level and the screen should be tilted so that the operator looks slightly downwards 
onto the screen.  The height of the monitor should be adjustable; this may require using a 
monitor stand to ensure it is at the correct height. 

 
 

Health Problems 
It is important that steps be taken to prevent health problems such as Occupational overuse 
syndrome (OOS) and repetitive strain injury (RSI) from occurring.  Exercises should be used to 
stimulate blood flow - to help reverse the effects of muscle tension - and help you to relax.   

sector 
=  division  

monitor 
=  screen  
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Physical Exercises 
There are exercises which, when done regularly, can help to prevent OOS.  These exercises are 
designed to reduce muscle tension and increase blood flow. 

   
Side neck stretch  
Slowly tilt your head to one side, 
stretching the side of your neck.  
Return your head to upright and 
repeat on the other side. 

Head turn  
Slowly turn your head to one side.  
Return to centre and repeat on the 
other side. 

Bi-directional neck stretch  
Bend your head forward and then turn 
your head to right.  Use your right 
hand to gently pull your chin down 
towards your armpit.  Repeat on the 
other side. 

   
Shoulder Roll  
Lift both shoulders upward toward 
your ears, and then down again 
slowly.  Roll your shoulders gently 
backwards and forwards to ease 
tension in the neck. 

Upper back stretch  
Clasp your hands behind your head, 
keeping your elbows straight out to 
the side.  Gently lean over the back of 
your chair, stretching your upper 
back. 

Upper arm and shoulder stretch  
Bend your right arm placing your right 
hand on your upper back.  Hold your 
right elbow with your left hand and 
use this hand to gently push your right 
arm down.  Repeat on the other side. 

   
Chest and shoulder stretch  
Interlace your fingers behind your 
back.  Gently turn your elbows 
inwards, straightening your arms. 
Pause and then release. 

Arm and rib cage stretch  
Interlock your fingers; stretch your 
arms above your head, palms 
upward.  Try to keep your shoulders 
lowered. 

Finger Spread  
Hold your right arm out bent upward 
at the elbow.  Spread fingers wide 
apart stretching the inner palm and 
fingers.  Repeat on the other side. 

   
Chair twist  
Sit in a chair with your left knee 
crossing your right.  Place your right 
hand on the outside of your left knee.  
Twist and place your left hand on the 
back of the chair.  Hold and repeat on 
the other side. 

Front wrist stretch  
Hold your right forearm out straight, 
palm facing up.  Take your fingers 
with your left hand and pull them back 
gently so the front of your wrist is 
stretched.  Repeat on the other side. 

Back wrist stretch  
Hold your right forearm out bent 
upward at the elbow.  Take your 
fingers with your left hand and pull 
them gently downward so the back of 
your wrist is stretched.  Repeat on the 
other side. 
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Eye Exercises  
To avoid eye strain when using a computer screen do the following: 

 Blink often to prevent the surface of your eyes drying out and becoming irritated. 

 Stare off into space - every now and then look across the room or out the window. 

 Adjust your screen so it is not too bright. 

 Use a glare screen to minimize glare reflected back into your eyes. 

 Wipe the dust off your screen regularly. 

 Use the clock at the right to practise eye exercises (you can also 
do these exercises in greater movements shown in brackets 
below). 

12 to 6 (from ceiling to floor) 

9 to 3 (from one side of the room to the other) 

1 to 7 

11 to 5 

Now close your eyes for a few seconds, relax and open your 
eyes.  Begin at 12 and circle around to 3, 6, 9 and back to 12 three times. 

Reverse directions, then close your eyes and relax. 

 To release tension in your face around your eyes, close them tightly and gently squeeze, 
allowing your facial muscles to draw up.  Hold for two seconds, relax your face and open 
your eyes, then open your mouth wide while raising your eyebrows.  Repeat three times. 

 

Work Breaks 
Operators should be given frequent breaks away from their terminals in order to avoid 
eyestrain and posture problems.  The recommended break is 10 minutes every hour worked 
where work is screen-intensive. Try to vary tasks and take a break from your computer to do 
filing, make business phone calls etc. 
 

Micropauses 
A micropause is a short break in work for muscle relaxation.  Specifically, it is a 5-10 second 
break in work for muscle relaxation every three minutes or so.  Micropauses allow for the 
restoration of blood flow to muscles which have been held tense.  It is when the muscles relax 
fully that micropauses are of most value.  They help you be more productive.  A variation to 
exercises is simply to count your breaths. 
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Starting Microsoft Word 2013 

 EXERCISE 1 

1 If the Start screen shown below is not displayed click on the Windows key 
on your keyboard OR move your mouse pointer to the very bottom left of the 
window where the Start button shown at the right is displayed.  
 

 

2 Click on  at the bottom right of the screen then on the Word 2013 program 
icon shown at the right.  

Microsoft Word will open.  If Word 2013 has been used previously then Backstage View 
will be displayed as shown below.  (Recent documents are shown at the left. 

 

Click here to scroll 
across the screen 

Click here to display 
the Start button 
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3 Click on Blank document.  The screen will display with a new document, ready for you to 
enter text as shown on the next page. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

The  tab contains all basic tasks such as opening, saving and printing a document. 
 

 
 

Quick Access Toolbar  

The Quick Access Toolbar contains commands to Save, Undo and Redo.  Other frequently used 
commands can be added to this toolbar.   

 

 
 
 

The Ribbon 

The ribbon in Microsoft Word 2013 is divided into tabs and groups as shown below.   
 

 
 

 
 

  Groups 

 

Tabs 

 

File tab 

Group 

 

Rulers 

 

Note:   
If Rulers are not displayed click 

on the View tab then click in the 
Ruler check box. 

 

Quick  
Access 
Toolbar  

Insertion point 

Ribbon 

Vertical 
Scroll Bar 

Vertical 
Scroll Box 

Help 
Ribbon Display 
Options Minimize 

Restore 
Down 

Close 

Status Bar Document Views Zoom Controls 

Tabs Title Bar 

Rulers 

 

Note:   
If Rulers are not displayed 
click on the View tab then 

click in the Ruler check box 
 

Save 

Undo Redo/Repeat Sa
m

pl
e D

oc
um

en
t



© Cherylprice.co.nz Limited SECTION 1    9 

Defaults 
The term defaults is given to the settings that occur for every new document you create, eg. 
margins, tabs, font, paper size. 

In Word programs default settings occur for every document you create.  These are shown 
below (from changes made at the beginning of this book). 
 

 New Defaults 
Margins  

 Top 2.54 cm (1") 

 Bottom 2.54 cm (1") 
 Left 2.54 cm (1") 
 Right 2.54 cm (1") 
 Header/Footer 1.25 cm (0.5") 

Tabs Automatically set every 1.27 cm 

Paper Size 21 cm x 29.7 cm (A4) 

Spacing Single 

Font Arial 11 pt 

Justification Left 

 
 
 
 
 
 
 
  

Header Margin - 1.25 cm (0.5") 
(for page numbering, text on each page, etc) 

 
Top Margin - 2.54 cm 

(1") Paper Size - A4 
21 cm x 29.7 cm 
(8.27" x 11.69") 

This is Arial 11 pt font shown on A4 paper 
size with 2.54 cm (1”) margins and left 
justification, ie a ragged right margin. 

Footer Margin - 1.25 cm (.5”) 
(for page numbering, text on each 

page, etc) 

Right Margin - 2.54 cm 
(1”) 

Left Margin - 2.54 cm 
(1”) 

Bottom Margin - 2.54 cm 
(1”) 
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Saving and Printing your work 

When you have finished keying in your exercises it is a good idea to save your work, print it out 
and then check for errors against the page(s) you have done.  

Saving 
Please refer to the Changing Defaults instructions on page xii at the front of the book to ensure 
you have turned off Backstage view when saving (otherwise you need to click on Computer, on 
Browse then navigate to the correct location). 

1 Click on the Save button  on the Quick Access Toolbar  at the top left of 
the screen  

OR click on the  tab then on . 

2 Ensure the correct location for your documents is displayed. 

3 Type a file name for your document.  

A file name can contain up to 255 characters in the main part of the file name. 

4 Click on Save. 
 

Printing 

1 Click on  then on .  A preview of your document will be displayed.   

2 Select print options required then click on . 
 

Close 

 Click on  then select . 
 

Open  

1 Click on  then select .   

2 If the file you require appears in the Recent Documents list double click on the file. 

Otherwise click on and then click on  to search for your file. 

3 Click on the file required then click on Open OR double click on the file.   
 

  

Ctrl O  

Ctrl S 

Ctrl P 
then 
Enter 

Ctrl W  
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Spell-check 
Spelling/typing errors will be displayed with a red wiggly line underneath, eg persistent and 
incorrect grammar is shown with a green wiggly line.  

Remember to click on the  tab and then on  to spell-check your work.   

To change Spelling and Grammar options click on the  tab, choose  then 
Proofing. 
 

AutoRecover 
Often people assume that the Automatic Save feature (AutoRecover) on a computer will save 
their work and they can open a document at another time.  The Automatic Save/AutoRecover 
feature is only a safeguard against your system crashing or against power failure.  When you 
close a document the Automatic Save/AutoRecover feature does not save that document.  It 
only works when you do not close a document and exit Word. 

The document is saved at the time interval specified by clicking on the  tab, selecting 

 then clicking on Save:  

 

After machine/power failure, when you next enter Word the file name will be displayed on the 
Document Recovery pane at the left of the screen.  You will need to open your document and 
save it with the same file name. 
 

Exiting from Word 

 Click on the Close button  at the top right of your screen OR on  at the top left of 
your screen and select Close. 

 
 

Have you noticed the shortcut keys on these pages?  Look at the left margin where they are 
displayed the first time a Word feature is used.  They are an easy method for using many 
features: 

Ctrl S to Save;  Ctrl P then Enter to Print;  Ctrl W to Close;  Ctrl O to Open, F7 for Spellcheck;  
Alt F4 to Exit  
 

Shutting down your Computer 
1 Move the mouse pointer to the far top right corner of the screen. 

2 Click on   then on  which displays the options 
shown at the right.  

3 Select Shut down. 
  

F7  

Alt F4  
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Keyboard Position 

Sitting Position 
Sit with back supported, feet flat on floor. 
 
 

 
 
 

Position of Hands 
Fingers should be gently curved over keyboard, thumbs above the Spacebar.   

Ensure that wrists are not raised; elbows should be comfortably alongside your body, not 
jutting out like wings. 
 

 
  

No pressure against 
the lower back and 
thigh 

40cm – 90cm 

Head not excessively 
bent over, inward 
curve at neck 

Angle between trunk 
and thigh between 90 
and 130 

Inward curve of the 
spine in the lumbar 
region 

Seat height adjustable 
450mm – 520mm 

About 90 angle 
between the upper 
and lower arms; upper 
arm near vertical 
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